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File Management

Perhaps you have been using Windows for a while, but still get confused about where
files are being saved. Moving/copying/deleting files and folders can be a scary
experience if you don’t know what you are doing. There are lots of ways to find files you
have misplaced. This course will cover all these topics. After the course, you should more
confident in the area of file management.

In this course you will be using the right mouse button for some tasks. If this document
indicates to click on an item, then you should use your left mouse button. This document
will indicate when you are to use your right mouse button. This course is a tutorial. The
sections of the document marked with the symbol €3 are exercises for you to try.

Create a Folder

With hard drives getting larger, and more applications being installed, it is very important
to organize your hard disk using folders. It is important for you to understand how your
hard disk is organized. A folder on your hard disk is like a folder in your filing cabinet.
You use it to save documents for an application, project or tasks of a similar type (e.g.
budget information).

To create a new folder, make the window active where you want the folder to appear.
Choose File ?New =>Folder. You new folder will look like the following

| Mew Falder

The default name of the folder is “New Folder”. Notice that the words “New Folder” are
highlighted in blue. This means that the words are selected. Simply type in a new name
for the folder (it is common for people to want to click their mouse button on the
highlighted text. Doing this will mean having to delete the characters “New Folder”.
More on this later). Hit <Enter> or click on a blank area in the current window to
complete the folder creation and naming process.

By the way, you can create a folder within a folder.
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1. Open My Computer & M:ASEWTPOI O[]

2. In your folder SewIp## File Edit Yiew Help

(located in the Sew/us$ on ﬁ ﬁ ﬁ @

‘Tlabnt’ (M:)), create a

Desktop MetHood Fecent  ivacationdoc
folder called My Work
File »New = Folder = type A
the name My Work E’ ﬁ,

3. Hit the <Enter> key. Start Menu Usger.dat by tafark

|7 abjectls) [191KE i

Move a Document to a Folder Using Drag-and-Drop Method

To move a document into a folder, simply click on the document and then drag the
document on top of the folder. Once the folder becomes dark in colour (highlighted),
release the mouse button. If the folder is already open, then click and drag the document
into the folder window. Open the folder to see if the document went inside. If you are
dragging a document from another disk (e.g. a diskette), the document will be copied, and
not moved.

€2 Move the document vacation.doc into your My Work folder.

Copy a Document to a Folder Using Drag-and-Drop Method

To copy a document into a folder, simply click on the document with your right mouse
button and then drag the document on top of the folder. Once the folder becomes dark in
colour (highlighted), release the mouse button. You will be presented with the following
window:

Copy Here
Move Here
Create Shaortcut(z] Here

Caricel

With your left mouse button, click on “Copy Here”.

o

1. Create a new folder called My Stuff.

2. Copy the document vacation.doc (currently located in the My Work folder) to
your new folder called My Stuff.

Open both folders to make sure vacation exists in both folders.
4. Close all open windows.

»
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File Edit “iew Help ﬁ ﬁ ﬁ

Dezktop MetHood Fecent

B ) = @

Start Menu Uszer.dat My Wik My Shuff

object(s] selected

Delete a Document

There will be times when you will need to delete a document and/or folders.
@ Simply select its icon, and drag-and-drop to the Recycle Bin on your desktop.
You will receive the following confirmation message so you don’t

R l= Bi .
mepme B accidentally delete a document:

Confirm File Delete |

Ae you sure you want to send "wacation.doc' to the Recycle Bin?
Mo |

i
Click on the Yes button to confirm the deletion. If you made a mistake, click the No
button to cancel the deletion. You can delete folders using the same method.

[

There are a couple other ways to delete a document. You can simply select the
document and then press the Delete key on your keyboard. Or you can right click on the
document, and select “Delete” from the following menu:
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Open

Scan far Viruses. .

b ake Available Offine
Open‘with...

3 Add ta Zip

£ Add to Aerostar. zip

SendTo r

Cut
Copy

Create 5 hortcut
Delete
Fename

Froperties

There is no right way or wrong way to do this...it is whatever you are most comfortable
with.

One thing worth noting here is that a document will remain in the recycle bin if the
document was deleted from the C-drive. This means you can recover it later (next topic to
be covered) . If you deleted a document from the M-drive, the network drive, then it not
recoverable from the recycle bin. You can empty the contents of the recycle bin by right
clicking on it, and then choosing “Empty Recycle Bin” from the following menu:

Open
E wplore
Empty Recycle Bin

Create Shartcut

Fropertiez

€3 Delete the document vacation.doc located in the My Stuff folder.

Recovery of Deleted Document from Recycle Bin

Sometime you may & Recycle Bin O[]
accidentally delete a document | Ele Edit “iew ﬂe'pl I I
Original Location Date Deleted Type

(Or fOlder)' TO recover the CowANDOWSYDes...  B/11/98 1:24 PM ticrosoft Word Do
deleted document, open the S|y thoughts bt CNWINDOWSWDes..  EA11/381:24PM Test Document
Recycle Bll’l and select the ‘i vacation.doc CowANDOWS Des...  B/11/98 243 PM ticrosoft Ward Do
document.

L | 0

|1 abject(s] selected 19.0KE W
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Note: When you open the Recycle Bin you will notice the document does not display as
a large icon but in list format. This is just another way to view your documents, so if
you feel more comfortable viewing your documents as icons, choose View =»Large
Icons.

Then choose File = Restore.

Edit Yiew Help

| The document will return to its original location. A
word of caution, as mentioned earlier, this method
only works if the document was originally stored on
S the C:drive. Unfortunately, as with today’s course
Ferame and in many offices across campus, you do not store
Fhemehs your documents on the C:drive. You would need to
contact your local computer support person for
assistance if a recovery is necessary.

Ermpty Recyelz Bin

[Ereate Shmrbet

- LCloze

Different Views and Arranging Icons

o O As shown on the left, the View menu
N allows you to display your documents four
[C e W = W) different ways: Large Icons, Small Icons,
% merme. et List, and Details. When first learning
Dot Windows 2000, many users prefer to view
ST —"— | as Large Icons. The List view displays
e cons more information about the document, such
p as its size, date, and type. You can also see

the various View options by right clicking
in the right pane , and choosing View.

7

1. Close any open windows.
2. Open My Computer =» Open the Hard drive (C:)
3. Use the View menu to try the four different displays.

Arranging Icons

You may want to sort your icons by name, type, date created, or size. The folders are
listed first, followed by the files.

€
1. Right click in the right pane, and choose Arrange Icons. Try By Date, and By

Name.
2. Close the My Computer window.

IST 03/19/03 6



Select Multiple Files

In a window, you can select more than one document at a time. If all the documents are
next to one another, click and drag a rectangle around them. You will notice a dotted line
as you move the mouse. If the documents aren’t next to one another, then press the Ctr/
key and click on each item. To select all files at once, choose Edit =»Select All. Once the
files are selected you can drag them as a group to a folder.

<

1. In your folder on the M:drive create a new folder called Personal Docs.
2. Use the above method to move the documents /etter.doc and budget.xls into
Personal Docs folder.

Copy a Document to a Floppy Diskette
Edit Yiew Help If you need to copy a document to a floppy diskette,

gr'i::“ T =l follow these instructions:
New ter 1. place a formatted diskette in your PC’s diskette
Quick Wiew bmp :
Add to Zip dere
ﬁr 2. select the document you want to copy

11 3. choose File »Send To=>3% Floppy (A:)
You will notice the light flash on the diskette drive

Send To Y| = 3% Floppy (A)

M Eudora Light . . . . .
= " § Eudnalis while the document is being written to the diskette.
Create Shortcut @ Eudura Fro Al . . d displavi hat’
Delete &4 Mai Resipient Using Mict SO nqtlce an ammatg sgreen 1splaying what’s
Rename 59 My Brisfease happening. Once the light is off, you can remove the
Fiopetes N Notenad exe diskette from the drive by pressing the ejection button.
L $34

1. Copy the document vacation.doc to the floppy diskette.

2. Check to see if the document copied to the diskette. (Hint: double-click on the
floppy drive in the My Computer.)

3. Close all windows.

Caution: when you format a diskette, all information on the diskette is erased during the
formatting process so be sure you aren’t formatting a diskette with important files you
will need later. If you aren’t sure, then check the diskette first by double-clicking on the
diskette drive icon in My Computer.

Windows Explorer

It is a lot easier to move documents and folders using Windows Explorer. There are three
ways to get into Windows Explorer:

1. While holding down the <Shift> key, double-click on “My Computer”.

2. Right click on the “Start” button, and then click on “Explore”.

3. Double click on “My Computer” and then click on the “aFalders | peion,

Using either one of the above techniques to start Windows Explorer, will result in a
Window that looks like the following:

IST 03/19/03 7



M= 3|

BX Exploting - My Computer
File Edit Wiew Tools Help

I g by Computer
Al Folders

= =] %

Contents of "My Computer'

| Type | Tatal Size | Free Space |
3% Inch Floppy Disk
Local Disk

CD-ROM Disc:

Marne

=3 2% Floppy [4:)
Iy = ()

i)

[ER=1n|

1.86GE 510ME

£ anim-2.2
{21 &pdemo
{27 bab hicks

2 Sewlusd on 'Tlab,..
=2 Sewl on 'Tlabrt' ;]
=2 Pestuft on 'Tlabnt'

Metwork Connection
Netwaork Cornection
Metwork Connection

1.99GE
1.99GE
1.00GE

282ME
282MB
70ME

/-7 Clientus

71 Clientws
7 Corel

#-{1] Eudora

{1 Exchanas
{27 Faontt

=0 wme left pane
(22 mape

7] Matlab

-] Mentor

£ My Documerts
-] MyFiles

{1 Medires

(] Program Files
- Qewin

1 Qws3270
7] Real

= @ Recpcled
-0 apbtools
- Syatat

- Training
-1 unzipped =
|0 abjectiz) [

e Start | [5G0 Fantoing - Mu Fomnn | Clio'nGave - Avac to mw stuff.. |

(58] Control Panel
(2] Printers

System Folder
System Folder

] ][]

right pane

M LA P

Notice the menus and toolbar at the top, and the right and left panes.

In the left pane are the various levels (or branches). The top level begins with the
Desktop (the starting place when you turn on your computer). The following levels are
My Documents (sits on your Desktop), My Network Places and Recycle Bin. Within My
Computer is the next level: 3% Floppy (A:), (C:), (D:), (M:) and other drives. These
drives contain more folders and files.

To view the contents of any folder, click the + - Clienhus
sign or double-click on the folder. If you
double-click, then the right pane will display
all its contents. Clicking on the — sign will
close the folder.

{7 Stationeny

Various Views
To view the contents as Large icons, Small icons, List or Details, simply use the View

menu OR click E- . The Detail-type view is popular as it provides more information,
such as size, type and date.

IST 03/19/03 8



View as Large Icons

View as Details

File Edt “iew Tools

Help

IgﬁewwsSon'Tlabnl'[M:] j E 0 .}ﬁllﬂ il > | E:‘:‘
All Falders Contents of M:\' k
{7 Font Navigator ;I
=0 Himipra E’ E’ E’ E’ E’ E
1 mapedit SEWTing Sewlpdl Sewlpl2 Sewlpl3d SewlpD4 Sewlp
-] Matlsh
E-{] Mentor
£ m E = E B &
B0 MyFiles
[ Mcduee SewlplE Sewlpl? Sewlpld Sewlpld Sewlpll Sewlf
{1 Program Files
B0 Qewin
28 B B @ B @
-0 Real
@ Recpoled Sewlpl2 Sewlpld Sewlpl4 Sewlplh SewlplE Sewlp
B0 spbtocls
-] Systat
-1 Training E’ E’ E’ E’ E’ C
-0 unzipped Sewlpl®  Sewlpl3  Sewlp2l  Sewlp?l  Sewlp2?  Sewlp
{0 Windows
{0 ws_ftpas
&z @ W @ W
wgd D)
== Sewlp24 Sewlp2h Sewlp26 Sewlp? Sewlp28 Sewlp
-2 Sewl on Tlabnt
52 Pestuff on 'Tlabnt' [¥:]
..{&] Contral Panel E’ E’ E’
{2 Printers
Metwork Neighborhaod Sewlp3d Sewlp3l Sewlp32
§ Recycle Bin

|33 abjectis)

File Edit “iew Tools

B

|U bytes [Disk free space: 282M

Exploning - M:\

Help

|E55w1us$on'ﬂabnt‘ (M) j =% %llﬂ il X|| Bgl:
All Folders Contents of 'M:\' L%
{7 Faont Navigator ;I Name | Size | Type | todified
-0 Hmlpra3 (1 5EWTing File Folder  £/2/98 4:13PM
{10 mapedit (21 SewlpOl File Folder ~ 6/26/38 4:37 PM
{0 Matlah [ Sewlpl2 File Folder  6:/8/98 4:08 PM
%0 Mentor [ Sewlp03 File Folder  6:/8/98 408 PM
U“g myF[_’I““mB“‘S [ 5ewlpld File Folder  £/3/98 4:08 PM
#-L MyFiles (23 Sewlpl5 File Folder  6/8/98 4:08 PM
{2 MNediee
(21 Sewl pl6 File Folder ~ 6/8/98 4:09 PM
-] Program Files "
(20 Sewt pO7 File Folder  £/8/98 4:09 P
- Qewin
(21 Sewlpls File Folder  6/8/98 4:09 PM
-0 Gws3270 i
-0 Feal (20w p09 File Folder  £/8/98 4:03 PM
@ Frecycled (3 Sewip10 File Folder  B/8/98 4:09 PM
m-C] sybtools Ca5ewipm File Folder  B/2/98 4:09 PM
- Spstat [ Sewlpt2 File Folder  6/8/98 4:10 PM
- Training (1 5ewln1a File Folder 6/8/98 4:10 PM
-1 unzipped [0 Gewlpl4 File Folder  £/8/98 4:10 PM
F-C Windows [C3 Sewlpls File Folder  B/3/98 4:10 PM
3 ws_ftp35 [ Sewlnlf File Folder  6/8/98 4:10 PM
£ y2k (2 Gewlpl? File Folder  6/8/98 4:10 PM
Edg (D) [C Sewip1a File Folder  6/8/95 4:10 PM
= (2 Gewlp1a File Folder  6/8/98 4:11 PM
253 Sewl on Tlabrt [ Sewlp20 File Folder  6/8/38 4:11 PM
Pestuft an ‘Tlabnt
D"% ECS:“ ‘ ;” Ia nt (1) (3 5ewlp21 File Folder  6/8/92 4:11 PM
& Fr—— [ 5ewipz2 File Folder  £/8/98 4:11 PM
Network Neighborhaod 0 5w p23 F!\e Folder E/8/928 411 PM
Fiecycle Bin [Z Sewlp24 File Folder  £/8/93 4:11 PM
=1 |Ca5ewn2s File Folder  6/8/98 4:12 PM
|23 object(s) |0 bytes [Diisk free space; 282ME]

File Management Using Windows Explorer

You can do the same tasks in Windows Explorer as you did in My Computer, even though
the window appears different. You will notice there are menus, and a Taskbar with

commonly used commands appearing as buttons. (By the way, My Computer also has a

Taskbar, but you need to choose it from View =»Toolbar.)

IST
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Open your folder Sew1p## on the M:drive. Click on the “Felders b ytton.
Change the View =»Large icons.

Create a new folder with your first name

Rename this folder with your surname

Somewhere in your Sew1p## folder is the document my thoughts. Copy (not
move) my thoughts.txt to your newly created surname folder.

If you open a folder and need to go up one level at a time, use the toolbar button

called Up One Level, .

Open the document my thoughts.txt by double-clicking on its icon.
Exit from Notepad.

Close Windows Explorer.

03/19/03 10



Find a Document

Sometimes you need assistance to locate a
document on your computer. The Start
menu’s Search command does just that!
From Search’s submenu, choose For Files

or Folders.

JF\|E Edt WView Favortes Took

_.

Help

New Office Document
Open Office Document
jlas]

Realdne Plaver

Programs L4

Dacuments 4

Settings 4

@ Far Files o Folders. .,

& Onthe Internet. .,

@ Far Printers...

‘@ Using Microsaft Outlook. ..
@ For Internet audiofVidea. .
83 For People, ..

Search

Run...

Log CFF bihicks., ..

Shuk Down..

If you know the name of the document,

J bk - o= H@Sw[h L Folders @‘ X @‘v

you can type it in the “Search for files

J Address |® Search Resubs

R or folders named” windows.

Search

X | | Hame | InFolder

|Re\eva‘.‘ |

Qe @

Enker your search criteriato begin,

@ Search for Files and Folders

Search for fles o folders hamed:

p——

Contairing text

S

Look in

= Local Harddives [C:) M
Stop Search

[ Date
I Type
[ Siee
[ Advanced Options

a

zlme | 2. If you don’t know the name of the

document, type in some text from the
document in the “Containing text” box.
3. Indicate what disk to search for in the
“Look in” window.
4. In the Search Options window, you can
look for a file modified within a range.

‘D ohject{s)

e

1. Search for the document containing the words “file management” on the X-drive.

2. Open the document that was found.

IST
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Other Notes

Opening Each Folder in the Same Window (Windows 2000)

If you prefer to open each folder in the same window, you can set this as the default by
doing the following steps:

1. From the Start button, choose Settings, then Control Panel.
2. Click on Folder Options
3. Under Browse Folders, click on “Open each folder in the same window”.

Another Option: Using the Clipboard to Copy/Move Documents

Another method to copy and move documents is using the clipboard. Simply select the
document that you want to move or copy with your right mouse button, and click on copy
or cut. Now open the destination folder and choose paste. This is a good way to make a
copy of a folder.

Saving Documents from an Application

When you are ready to save a document from an application, you specify the drive, folder
and filename. You can create a folder on the fly. When you save a document, you get the
following window:

21x|
Save in: IE] Lacal Disk (C:) j - - & ¥ O ~ Toals =
Bob [ WINMT
4 cbtlib
Histary Documents and Settings
DRIVERS
o fireworks
icq
My Docurnents My eBooks
Iy Music
- Myweb
OLYMPUS
Desktop pranywhere

Prograrn Files
SYMNCHRO
i] TEMP

Faworites kst

:I‘—T-‘ File name:; |F\genda j Save I
Iy Mebwork
Flares Save as bype: IWord Docurnent (*,doc) j Carnicel |
&

When saving a document, it is important to understand some of the tools on the following
bar:

IST 03/19/03 12



Save in: I[:l Windows 2000 j = @ O R Tu:u:ul_s*

How Much Disk Space Do | Have Left?

This used to be a much more frequently asked question that it is now, because hard drives
are much bigger now. But it is still useful to know how much disk space you have used.
1. Double click on “My Computer”.
2. Right click on the drive you would like to examine.
3. Choose Properties

IST 03/19/03 13
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Project: File Management in Windows 2000

How much space is left on your C-disk?

. On the C-Drive, create a folder called “File Management”.

Copy the following documents from the X-drive to your “File Management”
folder
a. Expenses.xls
b. Budget2001.xls
c. Oldbudget.xls
Rename Budget2001.xls to Budget2002.xls
Delete the document Oldbudget.xls
Create a Word document that contains one line, and save it in your “File
Management” folder.
Make a copy of the “File Management” folder.
Copy the “File Management” folder to your diskette.

03/19/03
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